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Innledning 
 

Dette kompendiet er i utgangspunktet skrevet for studenter som studerer emnet 
videojournalistikk ved Høgskolen i Nord-Trøndelag, men de fleste temaer er såpass 
generelle at det også fungerer fint som en introduksjon til arbeidsflyt og redigering i 
Final Cut. 
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1 Ingest og arbeidsflyt Final Cut Server 
 

1.1 Koble til nettverksstasjon 
Hvis ikke Final Cut Server allerede er koblet til som nettverksstasjon må dette gjøres: 

• Åpne Finder 
• Go > Connect to Server… (cmd+K) 
• Server Address: afp://macgyver/Final Cut Server 
• Logg på med [studentnr]@student.hint.no og ditt passord.  

 

 
 

1.2 Ingest og nytt Final Cut Pro-prosjekt 
• Kontroller at kamera er avslått. 
• Koble sammen kamera og redigeringsstasjon med FireWire-kabel. 
• Slå på kamera i VCR-modus. 
• Start Final Cut Pro. 
• Final Cut Pro > Easy Setup… (ctrl+Q): 

o Format: PAL 
o Rate: 25,00 fps 
o Use: DV-PAL Anamorphic 
o Bekreft med ”Setup” 

 

 
 

• Eventuelt: File > New Project… (shift+cmd+N). 
• File > Save Project As… (shift+cmd+S): 

o Browse til lokal ”Desktop” 
o Save As: bruk riktig navnekonvensjon 

 Navnekonvensjon: <studnr>-<emne>-<oppgid>-<tittel>.fcp 
 Eksempel: 000000-mmt102-oblig1-Desembergata 24.fcp 
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o Bekreft med ”Save” 
 

 
 

 
 

• Final Cut Pro > System Settings… (shift+Q): 
o Scratch Disks > Video/Audio Capture/Render > Set… 
o Browse til Final Cut Server/Final Cut Pro Documents/ 
o Bekreft med ”Choose” 

 

 
 

o Bekreft videre med ”OK” 
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Tips: Under User Preferences på Final Cut Pro menyen kan du ta bort valgene 
”Report dropped frames during playback” og “Abort Capture on dropped frames”. 
Dette gjelder spesielt media som enda benytter tape (kassetter). 

 

• File > Log And Capture… (cmd+8): 
o Bruk player-knappene for å navigere på båndet 

 

 
 

o Alternativ 1: Klikk ”Now” under Capture når båndet spilles av for å ta 
vare på akkurat det du ser (avslutt overføring med ”esc”-knappen) 
 

 
 

o Alternativ 2: Følg de neste punktene dersom du kun skal ta vare på flere 
enkeltklipp spredd på båndet 

o Søk deg fram, og sett inn- og utpunkt på materiale du skal ta vare på med 
”Mark in”- og ”Mark out”-knappene (hurtigtaster i og o) 
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o Klikk ”Log Clip” 
 

 
 

o Name: gi markert klipp et passende navn 
o Bekreft med ”OK” 

 

 
 

o Klippet vil nå være tilgjengelig i aktiv Bin (men fremdeles ”offline”): 
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o Gjenta de 5 første punktene under ”Alternativ 2” til alle relevante klipp på 
båndet er merket 

o Nå kan du merke alle klippene som er ”offline” (de som har rød strek på 
tvers overs seg i browser) og deretter Ctrl-klikke og velge Batch Capture, 
evt. følge stegene som beskrevet under her: 

o Klikk ”Batch” (under Capture) 
 

 
 

o Capture: All items in Logging Bin 
o Bekreft med ”OK” 
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o Bekreft at du har riktig bånd i kamera i dialogboksen ”Insert Reel” ved å 
klikke ”Continue” 

 
 

 
 

o Når alle klipp har blitt overført til disk bekrefter du med ”Finished” 
 

 
 



Kompendium Final Cut for Videojournalister 
 

Ståle A. Nygård og Håvard Sørli. HiNT, 2010. 9 

o Klippene skal nå være tilgjengelig i aktiv Bin, og klippingen kan starte: 
 

 
 

1.3 Opplasting av Final Cut Pro-prosjekt på Final Cut Server 
Når ”arbeidsdagen er ferdig”, og du skal forlate redigeringsmaskinen, må Final Cut-
prosjektet lastet opp på Final Cut Server slik at du (eller andre) kan finne det igjen 
senere. 

Først må du sørge for å ha lastet ned Final Cut Server Applet. Dette kan gjøres fra 
følgende nettsted for HiNT’s Final Cut Server:  

http://macgyver.student.hint.no/finalcutserver 

Velg Download og følg instruksjoner på skjermen. 

 

• Tilbake i Final Cut Pro må du eventuelt lagre prosjektet: File > Save Project 
(cmd+S). 

• Start ”Final Cut Server” (appleten), og log på med studentbrukeren. 

 
 

• Dra-og-slipp Final Cut-prosjektet fra desktop’en over til Final Cut Server-
browseren. 
 

http://macgyver.hint.no/finalcutserver�
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Alternativ: Velg ”Upload File…” i ”Server”-dropdown-boksen og browse deg fram 
til riktig prosjektfil: 
 

 
 

• Angi relevante metadata for prosjektet. Bekreft med ”Upload”. 
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• Når prosjektet er ferdig lastet opp kan du søke det opp (klikk ”Search”) for å 
forsikre deg om at det er tilgjengelig på Final Cut Server. 
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1.4 Utsjekking av prosjekt på Final Cut Server for videre redigering 
For å redigere videre på et eksisterende prosjekt som er lastete opp på Final Cut Server 
er det viktig å ”sjekke ut” prosjektet først slik at all versjonshåndtering blir ivaretatt, 
samt at alle andre potensielle redigerere av prosjektet da vet at noen andre jobber på 
det nå. På samme måte er det viktig at prosjektet blir ”sjekket inn” igjen når du er ferdig 
med redigeringsøkten. 

• Start ”Final Cut Server” (appleten), og log på med studentbrukeren. 
• Søk deg fram til riktig Final Cut-prosjekt, og merk det (klikk en gang). 
• Klikk ”Check Out”-knappen. 

 
 

 
 

• I dialogboksen ”Check Out Final Cut Pro Project” velger du å lagre prosjektet 
(Destination) på desktop’en (klikk ”Choose…” og browse deg fram). Bekreft med 
”Check Out”. 
 

 
 

• Prosjektet er nå merket med at det er utsjekket av deg (blyantikon); dvs. ingen 
andre har mulighet til å sjekke det ut nå. 
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• Åpne prosjektet i Final Cut Pro, og fortsett redigeringen av prosjektet. 

 

1.5 Innsjekking av utsjekket prosjekt på Final Cut Server 
• Eventuelt: Lagre prosjektet i Final Cut Pro: File > Save Project (cmd+S). 
• Eventuelt: Start ”Final Cut Server” (appleten), og log på med studentbrukeren. 
• Søk deg fram til utsjekket Final Cut-prosjekt, og merk det (klikk en gang). 
• Klikk ”Check In”-knappen. 

 

 
 

• I dialogboksen ”Check In Final Cut Pro Project” legger du inn en beskrivende 
versjonskommentar (Version Comments), angir riktig ”Kategori” og ”Status”, og 
bekrefter med ”Check In”. 



Kompendium Final Cut for Videojournalister 
 

Ståle A. Nygård og Håvard Sørli. HiNT, 2010. 14 

 

 
 

• Prosjektet (og eventuelt nye tilhørende medier) lastes nå opp på Final Cut Server, 
og prosjektet blir gjort tilgjengelig for utsjekking igjen (av deg eller andre). 

 

1.6 Eksport av prosjekt på Final Cut Server for redigering av egen 
versjon 

Hvis du kun skal ta en titt på et eksisterende prosjekt som er lastet opp på Final Cut 
Server, eller hvis du skal ta utgangspunkt i et eksisterende prosjekt og jobbe videre med 
en ny versjon av denne, har du mulighet til å gjøre en ”eksport” av prosjektet. Du har 
også mulighet til å eksportere låste prosjekter, og prosjekter som er sjekket ut av andre. 

 

• Start ”Final Cut Server” (appleten), og log på med studentbrukeren. 
• Søk deg fram til riktig Final Cut-prosjekt. 
• Dra-og-slipp prosjektet fra Final Cut Server til desktop’en. 

 

 
 

• Alternativ: Høyreklikk (ctrl+klikk) på prosjektet i Final Cut Server og velg 
Export… 
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• Åpne prosjektet i Final Cut Pro. 
• Alternativ: Du kan også dra-og-slipp prosjektet fra Final Cut Server og direkte på 

Final Cut Pro-ikonet i dock’en. 
• Hvis du skal lage egen/ny versjon, gi prosjektet et nytt navn: File > Save Project 

As… (shift+cmd+S). Bekreft med ”Save”. 
 

 
 

 
 

• Start redigeringen av egen/ny versjon. 
• Ferdig redigert versjon lastes opp i Final Cut Server på samme måte som nye 

prosjekter. 



Kompendium Final Cut for Videojournalister 
 

Ståle A. Nygård og Håvard Sørli. HiNT, 2010. 16 

 

 
 

 

 

1.7 Andre Final Cut Server-finesser 

1.7.1 Låse prosjekter 

Hvis du ikke ønsker at andre skal ”sjekke ut” og fortsette på et prosjekt du har sjekket 
inn, kan du låse dette ved å klikke ”Lock”-ikonet i Final Cut Server (prosjektet låses opp 
vha. samme ikon). 

 

 
 

Dette kan være aktuelt i tilfeller hvor det er viktig at du fortsetter fra der du slapp, eller i 
tilfeller hvor det er naturlig at dette prosjektet er ferdig.  
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Et par kommentarer omkring låsing: 

 

• Selv om prosjekter er låst kan man eksportere en kopi av dette (for å jobbe 
videre med denne som en egen versjon). 

• Selv om prosjektet ”ditt” er sjekket ut, redigert, og sjekket inn igjen, har du likevel 
mulighet for å hente din gamle versjon dersom du ønsker dette. Final Cut Pro har 
en god versjonskontrollfunksjonalitet som gjør dette mulig. 
 

 
 

1.7.2 Offline-redigering 

Hvis du vil jobbe med et prosjekt ”offline” (dvs. på et sted hvor du ikke har Macgyver 
tilgjengelig som nettverksstasjon) krysser du av for ”Keep Media with Project” når du 
sjekker ut eller eksporterer. 

 
Du kan for eksempel velge å lagre prosjektet på en ekstern harddisk, koble harddisken 
til hvilken som helst annen maskin og åpne Final Cut-prosjektet der for videre 
redigering. 

Når du laster ned prosjektet på denne måten vil det også lastes ned en originalkopi av 
råmateriale (legger seg i en undermappestruktur ved siden av prosjektnavnet), så en 
slik eksport/utsjekking kan ta lang tid. 

Innsjekking/opplasting til Final Cut Server skjer på samme måte som ellers. Final Cut 
Server vil automatisk detektere hvilket råmateriale som allerede finnes på serveren 
(lastes ikke opp), og hva som er nytt råmateriale (lastes opp). 
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2 Redigering i Final Cut Pro 
 

Dette kapitlet forutsetter at du har fulgt de instruksjoner som ble omtalt i kapitlet om 
”Ingest og arbeidsflyt i Final Cut Server”.  Forutsetter derfor at det eksisterer et 
råmateriale og at det er opprettet og lagret et prosjekt i Final Cut Pro. 

 

2.1 Oppsettet/Grensesnittet i Final Cut Pro. 
Standardoppsettet i Final Cut Pro er veldig likt andre redigeringsverktøy.  

 
Browser viser det materialet du har tilgjengelig i ditt prosjekt og andre prosjekter. 
Herfra kan du også få tak i effekter fra effektfanen. 

Viewer benyttes til å se på kildemateriale, samt justere på ulike motioneffekter og filter. 
I første omgang benyttes dette vinduet til å sette inn- og utpunkter på det stoffet vi 
ønsker å benytte i vårt prosjekt. 

Timeline er selve arbeidsflaten for klippearbeidet. Består av både lyd og videospor som 
kan ligge over hverandre og som kan aktiveres og deaktiveres. Kan sammenlignes med 
layers i Photoshop. 

Canvas er et videovindu som hele tiden viser det vi jobber med i timeline. Til slutt vil 
vårt ferdigklipte prosjekt kunne spilles av fra Canvas-vinduet. 

Tool palette. Her har du tilgang til en del viktige verktøy som du benytter under 
klippearbeidet i timeline. 



Kompendium Final Cut for Videojournalister 
 

Ståle A. Nygård og Håvard Sørli. HiNT, 2010. 19 

 
 

Audio Meters 

Her vises til en hver tid lydnivået på din produksjon. Viktig verktøy når du skal jobbe 
med lydjustering for å få mest mulig likt lydnivå. 

2.2 Viktigste steg for klipping av en nyhetssak i Final Cut Pro. 
1. Last inn materiale 
2. Organiser ditt materiale 
3. Finn tak i de sync´er du ønsker å benytte 
4. Finn gode innklippsbilder og forslag til anslag 
5. Lag kommentarblokker som følger det journalistiske fokus du har for saken. 
6. Finn gode bilder til etablering og knagging til kommentarene 
7. Lag første råklipp 
8. Finklipp saken din. 
9. Les på kommentar 
10. Rediger lyd 
11. Fargekorrigering 
12. Legg på grafikk/supring 
13. Eksporter ut saken din 
14. Last opp prosjektet ditt på Final Cut Server. 
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2.2.1 Innlasting av materiale 

Viser til første kapittel for denne prosessen. 

2.2.2 Organisering av materiale 

Før vi ser spesifikt på organisering av materiale i Final Cut, så er det noen generelle tips 
knyttet til arbeidsmetoder i denne prosessen. 

• Digitaliser i bolker, gjerne alle bildene som hører til en sekvens i en bit, eller hele 
råstoffet i en bit. 

I korte nyhetssaker med lite råstoff: 

• Digitaliser intervjustrekk i ett, gjør påsyn underveis og merk deg de sync’ene du 
vil bruke. Du kan lage sub-clips, og få de merkede bitene frem som egne "clip". 

• Ikke bruk tid på å navngi bildene (du kjenner dem fra hverandre når du ser 1. 
rute) 

 

• Bruk litt tid til påsyn og til å tenke struktur før du digitaliserer. 

I lengre saker (Feature/dokumentar saker): 

• Vær mer selektiv med hva du digitaliserer (fordi du har mer råstoff): 

o Å digitalisere 3 timers opptak tar mye tid! 

o Jo mindre råstoff på PC'en desto bedre oversikt får du 

• Vær forsiktig med å digitalisere lange strekk: 

o Lange strekk kan være vanskelige å få oversikt over. 

o Hvis du gjør det: Bruk sub-clips for å dele opp i kortere biter eller bruk 
locators (bokmerker) og legg hopp til neste/forrige locator på tastaturet.  

• Gi gjerne clip'ene navn 

De klippene du har lastet inn blir liggende i Browser. Hvis vi tar utg. pkt i en kort 
nyhetssak så vil du nå bare ha råmaterialet i en eller kanskje to deler, samt at du har tatt 
ut noen subclip på ting du ønsker å benytte (sync´er, anslag, gode innklippsbilder osv…) 

2.2.3 Legge materiale til timeline. 

Hvis du dobbelklikker på et av råmaterialeklippene slik at de kommer opp i Viewer, så 
kan du derifra lage et subclip ved å sette inn og utpunkt med bokstavene I og O, og 
deretter trykke cmd-U (Eple-U) eller velg Modify-menyen og Make subclip. Deretter kan 
du navngi subclip´et.  

Lage subclip:  

Dobbelklikk på det råmateriale i browser du ønsker å få opp i viewer. Deretter leter du 
deg frem til det du ønsker å benytte og setter et inn- og utpunkt med I og O. Nå kan du 
bare dra med deg dette klippet ned til timeline. Du kan også benytte deg av knappene 
Insert, overwrite eller replace, som ligger nederst i Canvas vinduet.  

Legg materiale til timeline: 

Insert legger klippet ned på timeline der hvor markør står (evt. Innpunkt er satt i 
timeline) og forskyver annet materiale mot høyre. En overwrite vil skrive over det som 
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evt. Ligger i veien for klippet i timeline, mens en replace vil erstatte hele klippet som 
allerede ligger i timeline. Du har også mulighet til å legge ned dette sammen med en 
overgang (transition). Dette ser du best ved å dra klippet fra viewer og over i canvas-
vinduet.  

Noen ganger kan det være ønskelig å bare ta med videosporet fra råmaterialet ned i 
Timeline (f. eks for innklippsbilder). Du setter inn- og utpunkt på samme måte som før i 
Viewer, men før du drar ned klippet så må du huske å deaktivere lydsporene. Dette 
gjøres ved å trykke på a1 og a2 (hvis det gjelder lydspor 1 og 2) til venstre i Timeline slik 
at det ser ut som på figuren under: 

 
Bilde 1: Link mellom lydspor og videospor i råmaterialet er fjernet. 

Klippene legges i timeline som du finner igjen som et sequence-objekt i browser. Denne 
må du også navngi. Det er vanlig at man i løpet av en produksjon har flere ulike 
sekvenser, f. eks ulike versjoner ut fra hvor langt man har kommet, eller hva det ferdige 
programmet skal distribueres til (TV, web osv…) 

Din browser kan nå se slik ut: 

 
Bilde 2: Browser med en sekvens, to råklipp og ett subclip. 

I bilde over har jeg navngitt en sekvens til 3D-printer ver. 1, jeg har to klipp med 
råmateriale som heter Råmateriale del 1 og 2, samt et subclip jeg har kalt Sync 1. Hva er 
dette. 

I denne fasen av redigeringen vil du stort sett jobbe deg gjennom råmaterialet for å finne 
det du trenger i din produksjon. Når ting er lagt i rekkefølge og du mener å ha det meste 
på plass, sier vi at du har den første klipp. Dette er som regel bare et utgangspunkt som 
det må jobbes mer med. 
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2.2.4 Finklipping 

Ofte vil den første versjonen vi kommer opp med være noe unøyaktig i klippepunktene. 
Det er derfor nødvendig å foreta noen finjusteringer. Et verktøy som er meget nyttig da 
er Trim. 

Før du starter med finklippingen er det viktig at du lager deg en ny versjon av din 
sekvens. Ctrl-klikk over sekvensnavnet i Browser og velg Duplicate fra menyen som 
kommer opp. Navngi dette f. eks til [navn på prosjektet]-versjon2. Du har nå mulighet til 
å gå tilbake til din første klipp hvis du skulle ”rote” deg bort i finklippingen. 

 

Det er flere måter å foreta en trim på. Jeg presenterer her kun de som er mest aktuelle. 
Du kan starte med Selection Tool (pila). Du utfører en trim ved å gå til klippepunktet 
mellom to klipp, eller før/etter et klipp og drar når muspekeren endrer seg til to piler i 
begge retninger. Du vil nå kun trimme på det ene klippet, og det vil enten legge igjen et 
sort hull, eller du kan benytte dette til å tette igjen hullet.  

Trimming: 

NB! Husk det er stor forskjell på å flytte et klipp og det å trimme et klipp. Når du 
flytter et klipp vil de opprinnelige inn og ut punkter bestå, og lengden på klippet vil 
også bestå. Det er kun plasseringen på timeline som endres. Ved en trim vil du 
forandre inn- eller utpunkt, samt du vil endre lengden på klippet. Klippet vil derimot 
ikke flytte plass på timeline. Prøv ut dette for å forstå forskjellene. 

 

Du kan også gjennomføre en trim som en roll eller slip ved hjelp av disse verktøyene fra 
Tool paletten. 

Med dette verktøyet kan du flytte klippepunktet  mellom to klipp ved å enten forlenge 
det første klippet og redusere det andre klippet, eller motsatt. Ved å bruke dette 
verktøyet vil du ikke endre på den totale lengden på produksjonen, bare flytte 
klippepunktet.  

Roll Tool: 

Verktøyet blir aktivt ved å velge det fra Tool paletten samt å bevege muspeker over det 
aktuelle klippepunktet. Klikk og dra for å utføre en Trim. Ved å bruke dette verktøyet vil 
du i Canvas vinduet få opp en visning over hva som til en hver tid blir de nye inn- og ut-
punktene på klippene.  

Hvis du kun ønsker å trimme det ene klippet, så kan du velge Ripple-tool

I tillegg finnes slip tool og slide tool. 

 som du finner 
under samme knapp som Roll Tool (hold inn knapp for å få frem verktøyet). I 
motsetning til Roll Tool så vil Ripple Tool redusere eller øke den totale lengden på 
produksjonen. 

Hvis du har behov for å dele et klipp opp i flere biter, kan du benytte Razor Blade. Dette 
finner du også på Tool Paletten. Verktøyet fungerer slik at du beveger muspekeren til 
det punktet du ønsker å dele klippet, og trykker. Da vil både bilde og lydsporene til det 
aktuelle klippet bli delt.  Hvis du f. eks kun ønsker å dele bilde klippet, så holder du nede 

Razor Blade. 
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Alt-tasten og trykker kun på bildesporet. Det finnes også et annen Razor verktøy som 
gjøre det mulig å splitte alle spor på et gitt sted i timeline. 

2.2.5 Legge på et innklippsbilde. 

Hvis du f. eks under en sync ønsker å benytte et innklippbilde går du frem på følgende 
måte.  

1. Lag et nytt videospor ved å ctrl-klikke i det grå feltet over sporene til venstre i 
Timeline og velg Add Track. Ett nytt videospor med navnet V2 dukker opp. 

2. Gjør klart innklippbildet i viewer ved å sette inn- og utpunkt. 
3. Fjern link mellom lyd og bilde ved å trykke på a1 og a2 til venstre i Timeline. 
4. Dra innklippbilde på ønsket plass i videospor 2 over klippet med sync. 
5. Bruk enten selection tool eller en trim-tool til å finjustere plasseringen av 

innklippbildet. Tenk god knagging ift sync eller kommentar. 
6. Husk at videospor 2 må være aktivert for å vise videoinnholdet. Sjekk de små 

grønne ikonene helt til venstre i Timeline for hvert videospor (gjelder også 
aktivering av lydspor). 

 

2.2.6 Legge på lyd 

Lyd som er aktuell i slike produksjoner er i hovedsak reallyd (lyd fra 
opptaksstedet/intervjulyd) og kommentar/speakblokk. I tillegg kan det i noen saker 
være aktuelt å legge på musikk og lydeffekter. 

Stort sett alle klipp i råmaterialet fra ulike locations har en eller annen form for reallyd. 
Dette kan være kontentumlyd fra omgivelsene, men kanskje viktigst lyd fra 
intervjuobjekter. Avhengig av hvordan du har stilt inn kameraet under opptak så finnes 
det ulik lyd i de ulike lydsporene på opptakene. Hvis du jobber alene vil du sannsynligvis 
bare benytte en mikrofon, og både intervju og kontentum ligger i en kanal. Med både 
fotograf og reporter kan mikrofon på kamera benyttes som kontentummikrofon (kanal 1 
- venstre), mens reporter har en egen mikrofon som benyttes under intervju (kanal 2 - 
høyre). F. eks kan dette se slik ut i timeline:  

 

 

 

 

 

 

 

Videospor 

Kontentum 

Intervju 
Bilde 3: Lydspor med ulikt innhold 
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Med å få dette inn i 2 separate lydspor kan man ved hjelp av lydredigering justere 
balansen mellom kontentumlyd og intervjulyd, evt. slette en av delene eller kopiere og 
gjenbruke lyden. 

Hvis du ønsker å legge på bare lyd fra et råmateriale vil fremgangsmåten være lik det 
som ble forklart i kap. 2.2.5, legge på innklippsbilde. Forskjellen er selvsagt at man nå 
drar ned kun det aktuelle lydsporet i stedet for videosporet fra råmaterialet. 

Legge på kommentatorlyd/Speakblokk 

I Final Cut har du mulighet til å legge på kommentar direkte i timeline. I utg. pkt kan du 
bare sette markøren på den plassen i timeline du ønsker at kommentaren din skal legges 
inn, og deretter velge Tools og VoiceOver.  

Valg i VoiceOver 

Du kan koble til en mikrofon på ulike måter til din Mac. Det beste er om du har et 
eksternt lydkort (f. eks en Mbox) men du kan også bruke mikrofoner på et kamera som 
er koblet til via Firewire. Når du får opp VoiceOver verktøyet skal du velge riktig 
lydinngang under valget Source. Hvis du benytter mikrofon på et kamera som er 
tilkoblet vha Firewire kan du velge DV Audio som vist i bildet under: 

 
Bilde 4: Voiceover ved å bruke Mic på kamera 

I dette tilfellet justeres inngangsnivået på lyd fra kameraet. Enten med AGC (auto gain 
control) eller manuelt. 

Voiceover på voice-lab. 

Ved HiNT har vi en egen dedikert voice-lab som benyttes til bl.a. kommentarlesing. Her 
benyttes en bedre mikrofon som er plassert i en lyddempet box samt en Mbox2 som 
eksternt lydkort på en Mac. Koblingene mellom enhetene kan illustreres slik: 
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Bilde 5: Illustrasjon lydkobling Voicelab, HiNT. (Aarlott, 2010) 

På denne maskinen må du huske å velge Mbox 2 som source i Voiceover verktøyet som 
vist på bildet under: 

 
Bilde 6: Voiceover ved å benytte Mic tilkoblet en Mbox 2 
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Inngangsnivået på lyden vil i dette tilfellet stilles på Mbox 2 (nivåknapp for enten input 1 
eller input 2).  

NB! Husk å stille Rate til 48.000 Hz i prosjekter hvor du jobber med audio fra DV-
opptak som også benytter 48.000 Hz som samplingfrekvens. 

Når du har stilt rett inngangsnivå på lyden og står på riktig plass i timeline, er det bare å 
trykke på den røde recordknappen og lese inn. (Husk å skru av lyd på høytalere som står 
nære mikrofonen du bruker). Du vil nå se videoen bli spilt av og kan evt. justere lesingen 
deretter, eller bare justere dette i ettertid. Legg merke til at videoavspillingen starter 5 
sec. før det punktet du valgte som startpunkt for kommentar (nedtelling). Når du 
trykker på stopp (samme knapp som record), vil kommentaren bli lagt som en lydklipp i 
et ledig lydspor. 

Importere musikk eller lydeffekter. 

Hvis du ønsker å legge til et lydspor fra enten en CD eller en lydfil, ctrl-klikker du i 
Browser og velger import. Finn tak i aktuell fil og velg Choose. NB! Forutsetter at man 
har rettigheter til å bruke lydmateriale i produksjonen. 

Justere lydnivå. 

Ingen ting er så irriterende som et ujevnt lydnivå mellom klipp i en produksjon. Dette er 
også med på å avsløre klippepunkter og gjør produksjonen mindre autentisk. Det er 
selvsagt først og fremst viktig at man stiller riktig inngangsnivå på lyd både på kamera 
og på lydkort når man gjør opptak, men en justering i etterkant er som regel nødvendig. 

Det er flere verktøy som kan benyttes i denne prosessen. Audio meter

Man kan endre 

 gir oss bare en 
visualisering av de lydnivåene som til en hver tid spilles av. Hvis man må gjøre 
endringer kan dette gjøres på ulike måter. 

lydnivå på et masterklipp (råmateriale) fra viewer

NB! Lyd som er tatt opp med for lavt nivå i utgangspunktet vil bli tilført mye 
støy/sus hvis man øker lydnivået for mye. Lyd som er tatt opp med for høyt nivå og 
som peaker under opptak, vil uansett være ødelagt om man reduserer lydnivået i 
redigeringsfasen. 

. Når du har et råklipp 
i viewer må du trykke på audio-tab’en. Her kan du benytte selection tool (muspeker som 
pil) til å endre på lydnivået. Den rosa streken representerer lydnivået. Ved å dra denne 
oppover økes lydnivået i db og motsatt. Den lilla streken representerer panorering 
mellom venstre og høyre. De samme operasjonene kan også gjøres ved å dra på sliderne 
Level og Pan. Spill av mens du drar på disse og følg med på audiometer. Dra nivået så 
høyt som mulig før det evt. peaker (blir sprengt). De endringene som her gjøres vil 
gjelde for hele råklippet. Altså hvis man på et råmateriale vet at man bør justere lyden 
litt opp eller ned for hele materialet, så er dette en smart metode. Husk at justeringen 
blir liggende lagret på råmaterialet, så neste gang det åpnes i viewer, så vil de 
endringene du har gjort også være aktive. 

 Man kan også justere på lydnivå på klipp som ligger i timeline. Da må du først aktivere 
Clip Overlays som gjøres ved å trykke en av knappen som ligger nederst til venstre i 
timeline. Knappen ser slik ut:  

Du vil nå se at du på lydsporene får en rød strek. Denne kan man dra opp og ned for å 
justere nivået på hvert enkelt klipp. 
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Du kan også bruke Levels fra Modify-menyen. Her har du i tillegg mulighet til å endre 
nivået på flere klipp ved at du først merker de klipp du ønsker å endre på i Timeline og 
deretter endrer gain i Levels verktøyet. 

Hvis du ønsker å justere på lydnivåene dine på en enda mer detaljert måte, kan du 
benytte keyframes. Dette kan benyttes både når du redigerer på lyd i viewer og i 
timeline. For å sette keyframes må du bruke Pen-tool. Enklest å bare trykke P for å 
aktivisere Pen-Tool. Trykk deretter på de plasser du ønsker å sette inn en keyframe på 
linja for lydnivå, og dra deretter de  ulike punktene til de nivå du ønsker. Smart hvis du 
skal dempe lyd i noen sekunder midt i et klipp, eller om du skal fade ut osv… Et lydklipp 
i timeline som har fått ulike keyframes og blitt lydjustert kan se slik ut: 

 
Tips: Du kan zoome inn i timeline ved å trykke Command + og du kan også lage 
visningen av et spor høyere ved å dra i nedre kant av sporet i timeline. 

For å fjerne en keyframe så kan du klikke og dra med deg punktet ut av sporet i timeline 
til muspekeren ser ut som en søppelbøtte. 

 

2.2.7 Noen enkle overganger/Transitions 

I en typisk nyhetssak er det ikke mange overganger som benyttes, men i noen tilfeller 
kan det være behov. Jeg viser derfor kort et eksempel på noen overganger/effekter som 
kan være nyttige. 

Motion effekt: 

Man kan enkelt øke eller redusere hastigheten på et klipp enten i Viewer eller timeline 
ved å velge Speed under Modify-menyen og sette den hastigheten man måtte ønske.  

Cross Dissolve: 

En helt enkel bildekryss som vanligvis er satt opp som default overgang i Final Cut. I så 
fall kan man bare klikke mellom de to klippene man ønsker å ha en overgang mellom og 
velge Command T, evt. gå på Effects-menyen eller effects-fanen i Browser. Der vel man 
selvfølgelig finne mange andre effekter også.  

NB! Effekter bør brukes kun hvis det har en direkte funksjon for enten å rette på 
ting, eller skal oppnå en visuell effekt som forsterker innholdet i produksjonen. 

2.2.8 Fargekorreksjon 

Fargekorreksjon og fargedesign er i utgangspunktet et eget fagfelt. Dette kapitlet vil 
derfor ikke ta tak i alt det som dette fagfeltet innebærer, men det vil gi deg en innføring i 
hvordan fargekorreksjonsverktøyet i Final Cut Pro fungerer og slik sett være et godt 
utgangspunkt for videre jobb med fargekorrigering.   

Forberedelser og innledning til fargekorreksjon  

Det er i hovedsak to hovedmål med fargekorreksjon:  

1. Å få tilbake det originale utseende fra opptaksstedet.  
2. Å modifisere det originale utseende slik at det er konsistens i fargene fra klipp til 

klipp og/eller gi en videoproduksjon et spesielt kreativt utseende.  
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Faser i fargekorreksjon  

Før vi ser litt nærmere på fargekorreksjonsverktøyet gir jeg her en oversikt over de 
faser som man normalt går gjennom ved fargekorreksjon:  

I den første fasen må man justere for fargespekteret eller kontrast ved å justere 
luminance (lyskontrast). Bilder som har et snevert fargespekter mister kontrast og 
detaljer i bildet. Du må også nøytralisere evt. fargestikk og korrigere hudfarge på 
mennesker.  

Fase 1: Få tilbake det originale utseende til hvert klipp  

Etter at du har korrigert individuelle klipp, må du gå igjennom din sekvens for å se om 
klippet fungerer mot klippene foran og bak. Hvis ikke må du korrigerer ytterligere.  

Fase 2: Oppnå konsistens mellom klippene  

Hvis du ønsker et særskilt utseende, legger du dette til ditt program til slutt i prosessen. 
For eksempel vil du at dette programmet ser ut til å være på kvelden eller om morgenen, 
evt. på vinter eller sommer.  

Fase 3: Skape det endelige fargedesignet på ditt program  

Fargekorreksjonsverktøyet i Final Cut Pro. 

Det som er mest normalt er at du korrigerer på hvert enkelt klipp i timeline såfremt du 
ikke har et råmateriale hvor alt må korrigeres. Da vil det være mest hensiktsmessig å 
laste råmaterialet inn i Viewer og korrigere alt før du legger klipp til timeline. 

Fargekorreksjon utføres normalt når selve klippearbeidet er ferdig og du har en 
tilnærmet ferdig produksjon i timeline.  

Gå igjennom produksjonen og prøv selv med det blotte øye å avdekke tydelige fargefeil 
eller får mørke/lyse bilder. De klippene som må korrigeres dobbeltklikker du på for å få 
lastet de inn i Viewer. Deretter kan du fra Effects-fanen i Browser finne Video filter og 
Color Correction. Velg Color Corrector som filter å dra dette opp på det klippet i timeline 
som trenger å bli fargekorrigert. Du vil nå få opp en ny fane i Viewer som heter Color 
Corrector. Gå til denne for å utføre fargekorrigering. 

I de fleste tilfeller så er det snakk om å redusere et blåstikk eller evt. gult, samt å øke 
eller redusere luminance (lyskontrast). Fargekorreksjon handler i stor grad om å bruke 
verktøyet og observere i Canvas vinduet hvilken innvirkning dette har på bildet.  

NB! Sørg for at du har videomarkøren i timeline på det klippet du korrigerer slik at 
du ser endringer i Canvas-vinduet.  

Tips. Slå av og på knapp ved siden av øyet øverst i verktøyet for å se forskjell på 
originalklippet og den korrigerte versjonen. 

Nedenfor ser du hvordan verktøyet for fargekorreksjon ser ut i Final Cut Pro. 
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Bilde 7: Fargerkorreksjonsverktøyet i Final Cut Pro 

 

2.2.9 Legg på grafikk 

Til slutt er det som regel bruk for å legge på en eller annen grafikk til produksjonen. I 
nyhetssammenheng trenger man i det minste en super til de intervjuobjekter som 
intervjues, samt info om hvem som er reporter og hvem som har vært fotograf og 
klipper. 

Det er selvsagt flere metoder å importere inn grafikk i Final Cut. Her vil jeg gi et 
eksempel på hvordan man kan benytte Adobe Photoshop til å lage en enkel super. 

Opprett først et nytt dokument i Photoshop med følgende innstillinger (Gjelder for DV 
16:9) 



Kompendium Final Cut for Videojournalister 
 

Ståle A. Nygård og Håvard Sørli. HiNT, 2010. 30 

 
Bilde 8: Oppsett for nytt dokument i Photoshop til en super i DV-PAL Wide format 

Ta utgangspunkt i Preset for Video og velg DV-PAL Widescreen. Viktig at man velger 
bakgrunn som transparent. 

Lag det du ønsker i Photoshop og lagre som en psd fil. Denne importeres inn i Final Cut 
ved å velge import i Browser. Lag deretter en eget videospor i Final Cut som du legger 
grafikk i. 
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3 Eksport  
I enkelte tilfeller ønsker man å ta vare på sakene i full kvalitet. Dette kan både gjøres 
digitalt til fil eller tilbake til tape. Først presentere jeg hvordan man gjør det tilbake til 
tape som har vært det vanligste i mindre redaksjoner. 

I prinsippet bør man ta hensyn til at sakene skal publiseres enten som de er, eller evt. 
med ny kommentar. Lag derfor to versjoner av saken, hvor den ene sekvensen har 
versjonen som skal til tape, og den andre den som skal publiseres på web. 

Hovedforskjellen ligger i hvordan man balanserer lydsporene og supring. 

3.1 Supring 
Saker som skal leveres til en redaksjon/arkiv skal IKKE ha med supring. Dette fordi evt. 
andre eksterne redaksjoner har sitt eget grafiske uttrykk som de benytter i super-
sammenheng. Slå derfor av det videosporet som suprene ligger i før eksport starter. 
Egen super benyttes stort sett bare i de tilfeller hvor saken skal på web. 

3.2 Lyd 
Når du spiller saken ut til bånd, panorer lydkanalene slik: 

Venstre kanal (kanal 1): 

• Ferdigmix til sending (mono): 
• Kommentar, intervjulyd, reallyd, kontentum, musikk (Dvs. ALL lyd) 

Høyre kanal (kanal 2): 

• I-lyd (mono) 
• Kun reallyd/kontentum (Dvs. den lyden som kan være aktuell å bruke i 

arkivsammenheng) 

Strengt tatt bør man kanskje kalle høyre kanal for "arkiv lyd" og ikke i-lyd, men begrepet 
i-lyd brukes i mange nyhetsproduksjonsmiljøer også om denne type panorering. Hvis 
man senere skal bruke saken med ny kommentar (f. eks hvis saken selges til utenlandsk 
TV) er ikke denne metoden god nok. Da bør høyre kanal inneholde all lyd bortsett fra 
kommentar = "egentlig" i-lyd. Da mister man imidlertid den rene reallyden som er nyttig 
i arkivsammenheng. 

Intervjulyd legges i noen redaksjoner i begge spor, dvs. også i i-lydssporet, men dersom 
intervjuet bildelegges, vil man med en slik metode miste den rene kontentum lyden på 
disse klippebildene. 

Hvis du bruker musikk og vil lage stereo, mister du muligheten til å lage i-lyd på båndet. 
Den eneste muligheten til å få. "spart" på i-lyden i det tilfellet, er å spille ut en ekstra 
versjon til bånd, hvor du ikke lager stereo, men panorerer musikken kun til venstre 
kanal. 

3.3 Print to Video (eksport til tape)  
I noen tilfeller kan det være aktuelt å kjøre ut produksjonen til tape. Sørg for å koble til 
et kamera eller en DV-deck via Firewire, og velg Print to Video fra File-menyen. Sørg for 
å velge Colorbar med en tonelevel/testtone på -12db. Sørg også for å klikke på for 
Autmatically start recording. NB! Sørg for å ha en tape i kamera eller DV-deck som er 
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spolet til på ønsket plass for utkjøring. Vinduet i Print to Video bør se slik ut før du 
trykker på OK. 

 
Bilde 9: Utkjøring til video og tape. 

3.4 Eksport til fil 
Hvis du ønsker å ha en digital fil av din produksjon i full kvalitet må du gjøre følgende. 

1. Sørg for å ha den sekvensen du ønsker å eksportere aktiv i browser. 
2. Gå på file-menyen og velg export og videre QuickTime movie. Du kan også ctrl-

klikke over aktuell sekvens i browser og velge export eller trykke hurtigtast  
Command E 

3. Gi filen et navn og velg en plass å lagre den. 
4. Under Setting velger du Current setting for å bruke samme innstillinger som 

prosjektet ditt, samt Audio og video under include og None på markers. 
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5. Viktig at du sørger for at valget Make Movie Self-Contained er valgt før du trykker 
på Save.  

 
Bilde 10: Riktige innstillinger for å eksportere ut en Quick-time fil i full kvalitet. 
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4 Opplasting og publisering av video på web 

Hensikten med dette kapitlet er å gi en innføring i hvordan man laster opp og publiserer 
video på 

4.1 Opplasting av video 

http://video.hint.no/. 

Opplasting av video gjøres på nettsiden http://video.hint.no/lastopp/. På denne 
nettsiden har man 2 valg: Man kan 1) laste opp en ferdig enkodet Flash Video (.flv), eller 
man kan 2) laste opp en video i "hvilket som helst" format for encoding på webtjeneren. 

4.1.1 1) Kode video selv vha. Adobe Media Encoder 

Dette kan gjøres på følgende måte: 

• Eksporter ut den ferdige produksjonen fra Final Cut Pro "QuickTime Movie" 
(.mov) som vist tidligere i notatet. 

• Start programmet Adobe Media Encoder. 
• Velg "Add..." og browse deg fram til .mov-fila du nettopp eksporterte. 
• I tillegg bør det endres litt på standardinnstillingene: 
• Under Preset velges Web Large, Widescreen (Flash 8 and Higher) 

 
Du skal endre litt på videostørrelsen for denne preset så gå inn på Preset på nytt og velg 
det nederste valget – Edit Export Settings… 

http://video.hint.no/�
http://video.hint.no/lastopp/�
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I dette vinduet skal du endre videostørrelsen. Velg først Resize Video og endre deretter 
bredden (width) til 512 og høyden (Height) til 288.  

Klikk "OK" for å lagre innstillingene. Du vil nå se at presetnavnet er endret til Custom 
pga dine endringer. 

Start enkodingen i Adobe Media Encoder vha. "Start Queue"-knappen. 

Når enkodingen er ferdig går du inn på http://video.hint.no/lastopp/ og velger menyvalget 
"last opp fil" øverst til høyre. 

 
Trykk på Bla gjennom… og browse deg fram til Flash videoen (.flv) du har enkodet, og 
sørg for at "Kun opplasting (.flv)" er avkrysset. 

Skriv eventuelt inn en tittel og beskrivelse og klikk "Last opp"-knappen. 

4.1.2 2) Enkoding på webtjeneren 

Hvis du ikke har en enkodingprogramvare som kan kode til Flash Video har du også 
muligheten til å laste opp andre formater. Enkodingprogramvaren på webtjeneren kan 
lese mange av de mye brukte videoformatene (MPEG-2, MPEG-4, H.264, QuickTime, 
Windows, osv.). Enkodingprogramvaren kan også lese DV-formatet, men husk at det 
maks kan lastes 500 MB store filer. 

http://video.hint.no/lastopp/�
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Det kan være lurt å bruke en kodek som gir god kvalitet, og velge en bitrate som gir lite 
kvalitetstap. Eksempel på godt format: H.264 (video), AAC (lyd), .mp4 (filformat), 1-2 
mbps (bitrate), 768x432 (oppløsning), 25 fps, deinterlaced. 

Opplasting/enkoding gjøres som følger: 

• Gå inn på http://video.hint.no/lastopp/ og velger menyvalget "last opp fil" øverst til 
høyre. 

• Browse deg fram til videoen du skal laste opp og encode. 
• Velg eventuelt andre innstillinger på oppløsning, bitrate, osv. 
• Skriv eventuelt inn en tittel og beskrivelse og klikk "Last opp"-knappen. 

Videoen blir lastet opp, og enkodingen vil starte umiddelbart. Enkodingen vil ta sin tid. 
På siden http://video.hint.no/lastopp/ vil statusen vise "Ferdig" når den er tilgjengelig 
som ferdig kodet Flash Video. 

http://video.hint.no/lastopp/�
http://video.hint.no/lastopp/�
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4.2 Lag webartikkel på video.hint.no  

4.2.1 Embedde video i artikkel 

For å embedde video i artikler på http://video.hint.no/ kan følgende fremgangsmåte 
benyttes:  

• Merk og kopier id'en til videoen du skal sette inn (klikk på id-boksen i tabellen du 
finner på http://video.hint.no/lastopp/). 

• Klikk på valget ”logg inn ez” i menyen til video.hint.no 

•  
• Logg deg på eZ Publish med samme pålogging som studentbrukeren din. 
• Velg mappen Videoreportasjer og lag ny ”Article” ved å trykke på Lag her 

knappen nederst i det nye skjermbildet. 

•  
• Lag ny artikkel ved å fylle inn tittel (Title), skriv ingress (summary). Ta også med 

hvem som har laget artikkelen i ingressen. 
• Legg inn videoen i Body. Du kan skrive mer tekst her også, men der er ikke 

nødvendig da teksten fra ingressen blir med. Sett markøren der du ønsker å sette 
inn videoen, og klikk knappen "selvdefinert element" <?> i editorens verktøylinje 
(se illustrasjon nedenfor). 

 

I dialogboksen velger du:  

• Selvdefinert element: mmtvideo 
• Egenskaper - Attributtnavn id: (kopier inn id'en til videoen fra første punkt) og 

legg inn bredde og høyde med samme verdier som vi satte i Adobe Media 
Encoder. 

 

http://video.hint.no/lastopp/�
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Videoen vil nå vises i editoren som et ikon (eventuelt som teksten du skrev inn i 
tekstboksen (du må se artikkelen i normal visning på video.hint.no for å se video). 
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4.2.2 Legg til pressebilde til artikkelen. 

For å legge med et bilde sammen med ingressen scroller du ned til seksjonen for Image i 
editoren. Velg Bla gjennom og last opp det bildet du ønsker å benytte.  

NB! Lagre og publiser artikkelen ved å scrolle deg ned ganske langt ned på siden 
og klikk på "Send til publisering"-knappen. 

 

Gå til http://video.hint.no for å se artikkelen. 

 

 

5 Vedlegg: 

5.1 Final Cut Pro Keyboard Shortcuts 
Hentet fra: 
http://www.peabody.jhu.edu/data/46/link/712/0331175FCPKYBDSHTCTQRC.pdf 
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General Controls

Open file

Open selected item

Open in separate window

Open item editor

Close window

Help

Quit

Save

Save all

Undo

Redo

Audio scrub on or off

Edit render quality

Looping on or off

Snapping on or off

Application Windows

Viewer

Canvas

Timeline

Browser

Effects

Favorites bin

Trim Edit

Log and Capture

Item Properties

Sequence Settings

Preferences



Final Cut Pro
Keyboard Shortcuts

+x O

return

shift return+

control + shift + return

+x W

+x ?

+x Q

+x S

+ Soption

+x Z

+x Y

shift S+

shift Y+

shift L+

N

+x 1

+x 2

+x 3

+x 4

+x 5

+x 6

+x 7

+x 8

+x 9

+x 0

+ Qoption



Select, Cut, Copy, and Paste

Copy

Cut

Duplicate

Make In/Out a selection

Paste

Paste attributes

Select all

Deselect all

Navigation

Forward one frame

Back one frame

Forward one second

Back one second

Match frame

Next edit

Previous edit

Next gap

Previous gap

Shuttle forward

Shuttle backward

To beginning of media

To end of media1

To next edit or In/Out

To previous edit or In/Out

To next marker

To previous marker

To master clip

1 Shift+Home has the same functions as the End key.

+ Doption

+ Aoption

+x V

+ Voption

+x A

+x D

+x C

+x X

F

shift E+

+ Eoption

shift G+

+ Goption

'

;

home

end

shift +

shift +

shift F+

shift +

shift +



Finding Items

Find

Find next (in Find results)

Find previous (in Find results)

Scrolling

Horizontal scroll left

Horizontal scroll right

Vertical scroll up

Vertical scroll down

Screen Layout and Display

Custom layout 1

Custom layout 2

Projects and Sequences

Import file

New project

New sequence

Browser

Toggle list/icon view

Insert bin

Open bins (list view)

Close bins (list view)

Make Favorite

Show logging columns

Show standard columns

Timeline

Create or break link

Linked selection on or off

Create or break stereo pair

Change track size

Clip Keyframes on or off

Clip Overlays on or off

Delete and leave gap

Ripple delete (no gap)

Fit sequence in window

Lock video track track number

Lock all video tracks

Lock audio track track number

Lock all audio tracks

+x F

+x G

shift F3+

shift + page
up

shift + page
down

page
up

page
down

+ Ushift

+x I

+x E

+x N

shift V+

+x B

option F+

option B+

shift B+

+x L

L

option L+

shift T+

option T+

option W+

delete

shift delete+

shift Z+

F4 +

shift + F4

F5 +

shift + F5

+ Uoption



Logging and Capturing

Log clip

Batch capture

Playing Video

Play/Stop

Play around current

Play every frame

Play here to Out

Play in reverse

Play In to Out

In and Out Points2

Set In point

Set Out point

Set video In only

Set video Out only 

Clear In

Clear Out 

Clear In and Out

Make selection an In or Out

Mark clip

Go to In point

Go to Out point

2 In and Out shortcuts follow a simple “set-go to-clear” scheme, using 
I or O for set, Shift+I or O to go to In or Out, and Option+I or O to clear
In or Out.

Markers3

Add marker

Add and name marker

Delete marker

Extend marker

Reposition marker

Next marker

Previous marker

3 Marker shortcuts follow a simple “set-next-previous” scheme, using 
M for set, Shift+M for next, and Option+M for previous.

I

O

J

+ Jshift

+ Ioption

+ Ooption

+ Xoption

+ Ashift

X

+ Ishift

+ Oshift

M

+M M

+x ~

shiftcontrol + + ~

F2

+x H

space bar

\

+ Poption

shift P+

shift space bar+

shift + \

shift + ~

shift + M

+ Moption



Editing

Apply default transition

Extend edit

Insert edit

Insert with transition

Overwrite

Overwrite with transition

Replace

Fit to fill

Superimpose

Make subclip

Slip edit click In or Out

Split edit click In or Out

Set target video track number

Set target video to None

Set target Audio 1 track number

Set target Audio 1 to None

Set target Audio 2 track number

Set target Audio 2 to None

Trim backward one frame

Trim backward 5 frames

Trim forward one frame

Trim forward 5 frames

Output

Change render quality

Display frame4

Print to video

4 Shift+F12 has the same function as the F15 key.

Compositing and Special Effects

Combine clips

Add Motion KeyFrame

Next Keyframe

Previous Keyframe

Make still frame

Render effect (FXBuilder)

Render selection

Render sequence

Render single frame on or off

Speed

Change Image/Wireframe view

Change RGB/RGB+A/Alpha 

Fit in window

Nudge position down

Nudge position left

Nudge position right

Nudge position up

Sub pixel down

Sub pixel left

Sub pixel right

Sub pixel up

Zoom in

Zoom out

+x M

Y

+x T

E

F9

shift F9+

F10

shift F10+

F11

shift F11+

F12

+x U

shift

option

F6 +

shift F6+

F7 +

shift F7+

F8 +

shift F8+

shift +

shift +

F15

+ Coption

K

shift K+

+ Koption

shift N+

+x K

+x R

+ Roption

caps
lock

+x J

W

shift W+

shift Z+

shiftcontrol + +

shiftcontrol + +

shiftcontrol + +

shiftcontrol + +

+x

+x

+x

+x

+x =

+x -



Tools Select Tool Plus Tool Plus Tool Plus 
Command (x) Shift Option

Select A Select additional Select range Link on/off

Edit Select G Select additional To Ripple tool Link on/off

Group Select G+G Select additional Select additional Link on/off

Range Select G+G+G Link on/off

Track Forward Select T All forward Link on/off

Track Backward Select T+T All backward Link on/off

Track Select T+T+T Link on/off

All Tracks Forward Select T+T+T+T Track forward Link on/off

All Tracks Backward Select T+T+T+T+T Track backward Link on/off

Roll Edit R Select additional To Ripple tool Link on/off

Ripple Edit R+R Select additional To Roll tool Link on/off

Slip S Select additional Select clip Link on/off

Slide S+S Select additional Select clip Link on/off

Razor Blade B To Blade All Link on/off

Razor Blade All B+B To Blade

Zoom In Z To Hand tool Zoom in maximum Zoom out

Zoom Out Z+Z To Hand tool Zoom out maximum Zoom in

Hand H Zoom in Zoom out

Crop C All sides Two sides

Distort D Perspective Resize

Pen P Smooth on/off Adjust line Pen delete

Pen Delete P+P Pen

Pen Smooth P+P+P
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